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1. INTRODUCTION 

TRIAZOLE 

Triazoles are an important class of heterocyclic compounds containing three nitrogen 

atoms in a five-membered ring having molecular formula C2H3N3. These exist in two 

isomeric forms depending upon the position of the nitrogen atom in the heterocyclic ring: 

1,2,3-triazoles or 1,2,4-triazoles. Both the structural isomers of triazoles exhibit 

tautomerism and exist in two tautomeric forms.  

                              

N

NHN

                                      

NH N

N  

                    1, 2, 3-triazole                                   1, 2, 4-triazole 

Out of the two isomeric forms of triazoles, 1,2,4- triazole derivatives are synthesized in 

the form of fused ring systems or as heterocyclic or aromatic substitutions [1]. 

In medicinal chemistry, five-member heterocyclic nitrogen-containing compounds such 

as triazole are of great importance due to their wide range of biological applications such 

as anticonvulsant [2,3] antimicrobial, antiviral, antitubercular, antidiabetic, anti-

inflammatory, anti-proliferative, antioxidant, anti-urease, and antimalarial activities [4]. 

1.1 1,2,4 TRIAZOLE 

The triazole ring contains three nitrogen atoms and can act as a hydrogen bond 

acceptor or donor at the active site of the receptors and can modulate their activity 

accordingly. Being polar in nature, the triazole nucleus can increase the solubility of the 

ligands and contribute better pharmacokinetic and pharmacodynamic properties [5]. 

Over the last decades, increased research has been devoted to 1,2,4 triazole drugs [6-

8]. Among them, 3-amino-1,2,4-triazoles derivatives have attracted special attention as 

they demonstrated a broad spectrum of bioactivities, including potential applications 

against thrombotic disorders [9], fibrotic [10], auto-immune diseases, central nervous 
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system disorders [11], obesity, diabetes, Alzheimer’s disease [12], microbial infections 

[13-15] cancer [16-19]. 

 

                                              

NH N

N  

                                                                                       

Molecular Formula       = C2H3N3 

Formula Weight: = 69.06532 

Composition = C (34.78%) H(4.38%) N(60.84%) 

Molar Refractivity = 16.86 ± 0.3 cm3 

Molar Volume = 54.2 ± 3.0 cm3 

Parachor = 155.1 ± 4.0 cm3 

Index of Refraction = 1.534 ± 0.02 

Surface Tension = 67.1 ± 3.0 dyne/cm 

Density = 1.274 ± 0.06 g/cm3 

Polarizability = 6.68 ± 0.5 10-24cm3 

RDBE = 3 

Monoisotopic Mass = 69.032697 Da 

Nominal Mass = 69 Da 

Average Mass = 69.0653 Da 

M+ = 69.032149 Da 

M- = 69.033246 Da 
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1.2 4- PYRIDINYL 1,2,4 TRIAZOLE 

 4-Pyridinyl 1,2,4 Triazole is a heterocyclic ring with nitrogen at 1,2 and 4 position 

and pyridine ring at 5 position their derivatives are characterized with a broad spectrum 

of biological activity, including anti-cancer activity, antiparasitic activity, larvicidal activity, 

antifungal activity, herbicidal activity, antioxidant activity, cytostatic activity, 

brassinosteroid biosynthesis inhibitors, antimicrobial activity [20]. 

                                            

N
N

NH

N
 

 

Molecular Formula       = C7H6N4 

Formula Weight: = 146.14934 

Composition = C (57.53%) H (4.14%) N (38.34%) 

Molar Refractivity = 39.55 ± 0.3 cm3 

Molar Volume = 112.7 ± 3.0 cm3 

Parachor = 322.6 ± 4.0 cm3 

Index of Refraction = 1 .619 ± 0.02 

Surface Tension = 67.1 ± 3.0 dyne/cm 

Density = 1.296 ± 0.06 g/cm3 

Polarizability = 15.67 ± 0.5 10-24cm3 

RDBE = 7 

Monoisotopic Mass = 146.059246 Da 

Nominal Mass = 146 Da 

Average Mass = 146.1493 Da 

M+ = 146.058698 Da 

M- = 146.059795 Da 
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1.3 CANCER 

Cancer is a condition where some of the cells of the body begin to divide 

uncontrollably and spread into surrounding parts of the body, destroying healthy 

neighboring tissues [21]. A cell receives instructions to die so that the body can replace it 

with a newer cell that functions better. Cancerous cells lack the components that instruct 

them to stop dividing and to die. Cancerous cells may appear in one area, then spread 

via the lymph nodes. These are clusters of immune cells located throughout the body 

[22]. 

 

Types of Cancer  

There are more than 100 types of cancer, usually named for the organs or tissues 

where the cancers form. In males, the most common cancers are that of lung, prostate, 

stomach, colon, and rectum. In females, the most common cancers are that of breast, 

colon, rectum, lung, and cervix. 

Stages of Cancer 

Stage means the extent to which the disease has progressed like the size 

of the tumor and if it has spread to the other parts of the body 

 

Stage 0: Cancer cells are present but have not spread to surrounding tissues 

 

Stage I, II, and III: Higher the number, more advanced the disease in terms of size of the 

tumor and invasion of surrounding organs and tissues 

Treatment of Cancer  

The treatment depends on the type and stage of cancer. Treatment includes 

radiation therapy, chemotherapy, surgery, and target therapy [23]. 
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Cancer statistics 

Cancers of oral cavity and lungs account for over 25% of cancer deaths in males 

and cancer of breast and oral cavity account for 25% of cancers in females. 

Breast cancer is the most common cancer in women in India and accounts for 14% of all 

cancers in women [24]. 

 

Table 1: The top five cancers in men and women account for 47.2% of all cancers 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MEN WOMEN 

LIP, ORAL CAVITY BREAST 

LUNG LIP, ORAL 

STOMACH CERVIX 

COLORECTAL LUNG 

ESOPHAGUS GASTRIC 
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EPIDERMAL GROWTH FACTOR RECEPTOR 

The epidermal growth factor receptor (EGFR; ErbB-1; HER1 in humans) is a 

transmembrane protein that is a receptor for members of the epidermal growth 

factor family (EGF family) of extracellular protein ligands [25]. 

Different receptor kinases are involved in the signal transduction in mammalian cells. The 

particularly important one is the epidermal growth factor receptor (EGFR), which is a 

transmembrane-bound molecule that has important regulatory functions affecting tumor 

growth and progression. These include cell proliferation, differentiation, migration, 

apoptosis, and angiogenesis.  

EGFR kinase, consisting of ErB1 and HER1, belongs to the ErbB family of kinases, which 

also includes human epidermal growth factor receptor-2 (subunits: HER2and ErbB-2), 

human epidermal growth factor receptor-3 (subunits: HER3 and ErbB-3), and human 

epidermal growth factor receptor-4 (subunits: HER4 and ErbB-4). 

 Food and Drug Administration (FDA) approved drugs targeting this family 

• monoclonal antibodies (trastuzumab, cetuximab, panitumumab, and pertuzumab)   

• Small-molecule inhibitors or tyrosine kinase inhibitors (TKI) 

(gefitinib, erlotinib, lapatinib and afatinib)  

EGFR inhibitors may be used in the treatment of cancers that are caused by EGFR up-

regulation, such as non-small-cell lung cancer, pancreatic cancer, breast cancer, and 

colon cancer [26]. 

Molecular targeting strategies for cancer therapy are distinct from conventional 

chemotherapy and radiotherapy in their potential to provide increased tumor specificity.  

One particular molecular target of high promise in oncology is the epidermal growth factor 

receptor (EGFR). The EGFR is overexpressed, dysregulated, or mutated in many 

epithelial malignancies, and EGFR activation appears important in tumor growth and 

progression [27]. 
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Tyrosine kinases 

Tyrosine kinases are important cellular signaling proteins that have a variety of 

biological activities including cell proliferation and migration.  

Multiple kinases are involved in angiogenesis, including receptor tyrosine kinases such 

as the vascular endothelial growth factor receptor. Inhibition of angiogenic tyrosine 

kinases has been developed as a systemic treatment strategy for cancer. 

Protein kinases phosphorylate proteins, resulting in functional changes of target proteins 

The tyrosine kinase group consists of approximately 30 families, for example, the VEGFR 

family and the fibroblast growth factor receptor (FGFR) family.  

Receptor tyrosine kinases are essential for the transduction of extracellular signals into 

the cell, while non-receptor tyrosine kinases accomplish intracellular communication [28]. 

Types of tyrosine kinases 

Tyrosine kinases can be further subdivided into 

• Receptor tyrosine kinases (EGFR, PDGFR, FGFR) 

 

• Non-receptor tyrosine kinases (SRC, ABL, FAK, and Janus kinase) 

Oncogenic activation of tyrosine kinase 

Normally the level of cellular tyrosine kinase phosphorylation is tightly controlled 

by the antagonizing effect of tyrosine kinase and tyrosine phosphatases. 

The common mechanism of oncogenic activation  

▪ activation by mutation 

▪ BCR-ABL and human leukemia 
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Mechanism of action 

EGFR tyrosine kinase inhibitors act by inhibiting the EGFR tyrosine kinases by 

competitive blockade of ATP binding. Eg: Gefitinib, lapatinib 

Selectively inhibits EGFR-TK results in blockage of downstream EGFR signal 

transduction pathways, cell cycle arrest, and inhibition of angiogenesis. [29,30]. 

 

Figure 1: EGFR signaling pathway 
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1.4 DOCKING 

Docking is a procedural method to predict the preferred orientation of one molecule 

to another when bound to form a stable complex. 

Docking is important in Drug designing which is used for calculating the  binding 

alignment of small molecular drugs or inhibitors to their protein targets and can predict 

affinity and activity of complex formed. 

Molecular docking is an attractive scaffold to understand drug biomolecular interactions 

for the rational drug design and discovery, as well as in the mechanistic study by placing 

a molecule (ligand) into the preferred binding site of the target-specific region of the 

DNA/protein (receptor) mainly in a non-covalent fashion to form a stable complex of 

potential efficacy and more specificity. The information obtained from the docking 

technique can be used to suggest the binding energy, free energy, and stability of 

complexes. At present, a docking technique is utilized to predict the tentative binding 

parameters of the ligand-receptor complex beforehand. 

The main objective of molecular docking is to attain a ligand-receptor complex with 

optimized conformation and to possess less binding free energy. 

Molecular docking can demonstrate the feasibility of any biochemical reaction as it is 

carried out before the experimental part of any investigation. There are some areas, 

where molecular docking has revolutionized the findings. In particular, the interaction 

between small molecules (ligand) and protein target (maybe an enzyme) may predict the 

activation or inhibition of the enzyme. Such type of information may provide raw material 

for rational drug design. Some of the major applications of molecular docking are Lead 

optimization, hit identifications, Drug- DNA interaction. 

 

 

 

 

https://www.omicsonline.org/drug-designing.php
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1.5 DRUG FILTERS 

CHEMSKETCH 

ACD/ChemSketch Freeware is a drawing package that allows you to draw chemical 

structures including organics, organometallics, polymers, and Markush structures. It also 

includes features such as calculation of molecular properties (e.g. molecular weight, 

density, molar refractivity, etc.),2D and 3D structure cleaning and viewing, functionality 

for naming structures (fewer than 50 atoms and 3 rings), and prediction of log P. 

 

SWISS ADME 

A free web tool to evaluate pharmacokinetics, drug-likeness, and medicinal chemistry 

friendliness of small molecules. It allows to compute physicochemical descriptors as well 

as to predict ADME parameters, pharmacokinetic properties, druglike nature, and 

medicinal chemistry friendliness of one or multiple small molecules to support drug 

discovery. 

ProTox-II 

ProTox-II, a virtual lab for the prediction of toxicities of small molecules. The prediction of 

compound toxicities is an important part of the drug design development process. ProTox-

II incorporates molecular similarity, fragment propensities, most frequent features, and 

machine-learning, based on a total of 33 models for the prediction of various toxicity 

endpoints such as acute toxicity, hepatotoxicity, cytotoxicity, carcinogenicity, 

mutagenicity, immunotoxicity, adverse outcomes (Tox21) pathways, and toxicity targets. 

Pre ADMET 

Pre ADMET-is a web-based application for predicting ADME data and building a drug-

like library using in silico method. It predicts permeability for Caco-2 cell, MDCK cell and 

BBB, HIA, skin permeability, and plasma protein binding. 
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2. REVIEW OF LITERATURE 

1. Guo-Xiang Sun et al were synthesized novel 1,2,4-triazole derivatives containing 

pyridine moiety under the Microwave Assistant condition and evaluated their fungicidal 

activities in vivo against Stemphylium lycopersici (Enjoji) Yamamoto, Fusarium 

oxysporum. sp. cucumebrium, and Botrytis cinereal. From the results compound with the 

electron-donating group at R, 4-BuPh at R (71.43%) and   4-OCH3Ph (85.12%) at R 

displayed excellent inhibition activity [6]. 

                             

N

N N

N
S

R

 

2. Modzelewska-Banachiewicz, B et al synthesized New 3-(3,4-diaryl-1,2,4-triazole-5-yl) 

propenoic acid derivatives (8–14) by condensation of N3 -substituted amidrazones (1–7) 

with maleic anhydride. From the results compound with 2-methyl pyridine at R1 and phenyl 

at R2 showed anticonvulsive activity and potent antinociceptive action [31].  

   

N
N

N

O

OH

R1

R2   

3. Metin Koparir et al synthesized novel aminomethyl derivatives of 4-substituted-5-(2-

thienyl)-2,4-dihydro-3H-1,2, 4-triazole-3-thiones and evaluated their biological activity. 

From the results compound with morpholine and piperazine at R showed effective 

antifungal activity; 4-methyl piperidine and trifluoromethylphenylpiperazine at R showed 

the highest antibacterial activity [32]. 
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N N

N S

R

CH3

S

 

 

4. Tatar E et al synthesized new series of 1,3,4-thiadiazole and 1,2,4-triazole derivatives 

from L-methionine and screened their antitubercular activity against Mycobacterium 

tuberculosis H37Rv strain. Among screened compounds 1-[4-(4-chloro-(3-trifluoromethyl) 

phenyl]-3-[3-(methyl-sulfanyl)-1-(4-phenyl-5-thioxo-4,5-dihydro-1H-1,2,4-triazole 3-yl) 

propyl] thiourea showed the significant antitubercular activity [33]. 

  

N NH

N
S

NH

S

CH3

NH

SH
Cl

 

 

5.  Liu XH et al synthesized novel fluorinated 1,2,4-triazole derivatives by Microwave-

assisted reaction and screened their herbicidal activity. From the results compound with 

fluorine at ortho and meta position of at R1, R2 showed the herbicidal activity against 

Brassica campestris and Echinochloa crusgalli.[34].      
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N N

N
S

NH O

R1

CH3
R2

 

 

6. Varvaresou, A et al synthesized New indolic derivatives of thiosemicarbazides and 

some cyclic 1,2,4-triazole-5-thione analogs and evaluated their antimicrobial and 

antifungal activity. From the results, thiosemicarbazides and cyclic triazole-thien-5-yl 

analogs showed similarities in the antimicrobial and antifungal activity. α-naphthyl 

substitution in the non-indolic portion and C5 substitution on the indolic nucleus active 

against S. aureus and C. Albicans [35]. 

                                                       

N NH

N

S

R
 

7. R.K. Mali et al Synthesized 3, 5-disubstituted-1, 2, 4-triazole derivatives and screened 

their Anti-fungal activity against C. albicans and A. niger and anti-tubercular against 

Mycobacterium tuberculosis [36]. 

                                                

N N

N

S

H

N
N

O

R1

R2

 

8. Nilufer Bulut et al synthesized Some novel derivatives of thiosemicarbazide and 1,2,4-

triazole-3-thiol and evaluated their biological activities. From the results among all the 
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synthesized triazole compounds 5,5′ -pyridine-2,5-diylbis(4-phenyl-4H-1,2,4-triazole-3-

thiol compound substituted with the aromatic phenyl group at R showed the highest DPPH 

radical scavenging activity [37]. 

                             

                                          

N N

N

SH

R

N

NN

N

R

 

9. Han MI et al synthesized a novel series of 1,2,4-triazole containing hydrazide-

hydrazones derived from (S)-Naproxen and evaluated their in vitro anticancer activity by 

using the MTS method against PC-3, DU-143, and LNC cancer cell lines [38]. 

                                              

N
+ N

N

S

R

NH

O N

CH3

F

CH3

 

10. Abdallah Turky et al  synthesized 1,2,4-triazole-N-arylamide hybrids and evaluated 

their anti-cancer using human breast adenocarcinoma cells (MDA-MB-231). The results 

showed that two novel C3-linked 1,2,4-triazole-N-arylamide hybrids with antiproliferative 

potentials [39]. 
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N N

N

S

R

O

NH

 

 

11. G.M. Castanedo et al synthesized a highly regioselective one-pot process that 

provides rapid access to highly diverse 1, 3, 5-trisubstituted 1, 2,4-triazoles from the 

reaction of carboxylic acids, primary amidines, and monosubstituted hydrazines. Where 

R is the alkyl and aromatic group [40]. 

                                                                                                                    

                                                   

N

N

N

R1

R2

R

                                                  

                                        

12. V. Ram et al synthesized 4- Substituted-5-Aryl-1, 2, 4-Triazoles and screened their 

Antibacterial and Antifungal Activity and found antibacterial activity. From the results 

compound with pyridyl at R exhibited antibacterial activity [41]. 

 

                                                   

N

N

N

R

N

CH3

CH3
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13. Ya-Ping Hou et al synthesized new 1,2,4-triazole derivatives containing 1,4-

benzodioxan have been synthesized and evaluated for their antitumor activities [42]. 

                                     

R1

N
N

N

O

O

SR2

R3

R4  

14. A new series of substituted 1,2,4-triazoles as substituted 4,5-diphenyl 4H-1,2,4-

triazole-3-thiols have been synthesized and evaluated for their biological activity. From 

the result synthesized compounds exhibited potent to moderate anti-inflammatory, 

anticonvulsant and antimicrobial activities [43]. 

                                             

N N

N

SH

R

R1  

15. Abdallah Turky et al designed and synthesized novel series of 1,2,4‐triazole 

derivatives as potential adenosine A2B receptor antagonists and evaluated in vitro 

cytotoxicity against a human breast adenocarcinoma cell line (MDA‐MB‐ 231) using the 

MTT assay method [44]. 
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N

N
S
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16.  Aouad MR et al synthesized of a novel series of S- and S, N-bis(acyclonucleoside) 

analogs carrying 5-(2-chlorophenyl)-2,4-dihydro-1,2,4- triazole-3-thione by convenient 

regioselective method and evaluated their anticancer activity in vitro using cancer cell 

lines [45]. 

                                    

                                      

N

N
+

NH

S

Cl

O

O

R

O

R

 

17. Kumar CS et al performed docking studies of novel 1, 2, 4- triazole containing 1h-

indole-2, 3-dione analogs as anticancer properties. indoleamine 2, 3-dioxygenase 1 (PDB 

ID: 5ETW), EGFR tyrosine kinase (PDB ID: 5HIC) docking was done by using Autodock 

software [46]. 

 

18. Aliwaini S et al designed, synthesized, Three novel pyrazolo-[1,2,4]triazolopyrimidine 

derivatives and evaluated their antiproliferative activity against tumor cell lines HCC1937 

and HeLa cells (EGFR) [47]. 
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19. Nasab RR et al synthesized new series of quinazoline derivatives and explored the 

interaction between epidermal growth factor receptor tyrosine kinase of the synthesized 

inhibitors using a combination of in-silico and in-vitro cytotoxicity methods.EGFR tyrosine 

kinase (PDB code 1M17) using Autodock 4.2 [48]. 

20. Ahirwar J et al designed and synthesized Analgesic and Anti-inflammatory Potential 

of Merged Pharmacophore Containing 1,2,4-triazoles and Substituted Benzyl Groups via 

Thio Linkage [49]. 

                                    

N N

N

S

H

N

R

 

 

21. Lamya H et al Synthesized of Novel 1,2,4-Triazolyl Coumarin Derivatives as Potential 

Anticancer Agents. Replacement of the thiol group in triazole with an arylamino 

substituent leading to the 6-arylamino derivatives [50]. 
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22. Aday HA et al synthesized N-(3-mercapto-5-phenyl-4H-1,2,4-triazol-4-yl) hydrazine 

carbothioamide by the condensation of 4- amino-5-phenyl-4H-1,2,4-triazole-3-thiol and 

thiosemicarbazide [51]. 

                               

N

N
N

SH
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23. Carolin. S et al synthesized 5-(4-Nitrophenyl)-4-phenyl-4H-1,2,4-triazole-3-thiol  from 

1-phenyl-4-(4- nitrobenzoyl)thiosemicarbazide and cytotoxicity assay on the 

rhabdomyosarcoma cell line of heavy metals [52]. 
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24. Li et al synthesized and evaluated in vitro anticancer activity of 12 hybrid 1,2,4- triazole 

Schiff's bases bearing γ-substituted butenolide moiety [53]. 
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25. Anton Smith et al. have been synthesized and evaluated in vitro anticancer activity of 

1,2,4-triazole derivatives [54]. 
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26. Mohsen et al Designed, synthesized, docking study, and cytotoxic activity evaluation 

of some novel letrozole analogs on breast cancer cell lines [55]. 

                                                    N

N

NN

N

 

              



                              Department of Pharmaceutical Chemistry 

 

 
C.L.BAID METHA COLLEGE OF PHARMACY        21       

 

 
3.AIM AND OBJECTIVE 

Cancer is one of the most life-threatening diseases, with more than 100 different types 

occurring due to some molecular changes within the cell. It is the third leading cause of 

death worldwide following cardiovascular and infectious diseases. It is estimated that 

12.5% of the population dies due to cancer. The disease is widely prevalent, and in the 

west, almost a third of the population develops cancer at some part of time during their 

life. Although the mortality due to cancer is high, many advances have been made both 

in terms of treatment and understanding the biology of the disease at a molecular level. 

There is a continuous rise of deaths from various cancer worldwide with an estimated 12 

million deaths in 2030. Despite the advancement in the knowledge of biochemical 

processes associated with carcinogenesis, the successful treatment of cancer remains a 

significant challenge because of the general toxicity associated with the clinical use of 

traditional cancer therapeutic agents. Hence, the design and development of new drugs 

for cancer therapeutics remains to be an important and challenging task for medicinal 

chemists worldwide. 

 

       The work is aimed at 

➢ To design pyridinyl triazole derivatives using chem sketch. 

➢ To perform docking studies for all designed compounds with EGFR tyrosine kinase 

using Autodock 4. 

➢ To synthesize pyridinyl triazole derivatives based on docking score. 

➢ To characterize the synthesized compounds using IR, NMR, Mass. 

➢ To evaluate the anticancer activity of the synthesized compounds. 
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4.PLAN OF STUDY 
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5.MATERIALS AND METHODS 

5.1. DESIGN OF COMPOUNDS: 

17 compounds were designed using Chemsketch software. Physicochemical properties 

were calculated for all the compounds. 

Molar refractivity 

Molar refractivity, A, is a measure of the total polarizability of a mole of a substance and 

is dependent on the temperature, the index of refraction, and the pressure. 

The molar refractivity is defined as    A= 𝟒 𝝅NA 𝛂/𝟑 

Where NA≈ 6.0221023 is the Avogadro constant and 𝛼 is the mean polarizability of the 

molecule. 

Molar Volume 

The molar volume, symbol Vm, is the volume occupied by one mole of a substance 

(chemical element or chemical compound) at a given temperature and pressure. It is 

equal to the molar mass (M) divided by the mass density (ρ). It has the SI unit cubic 

meters per mole (m3/mol), although it is more practical to use the unit’s cubic decimeters 

per mole (dm3/mol) for gases and cubic centimeters per mole (cm3/mol) for liquids and 

solids. The molar volume of a substance can be found by measuring its molar mass and 

density then applying the relation      Vm= M/p 

  Index of refraction 

    The refractive index or index of refraction of a material is a dimensionless number 

that describes how light propagates through that medium. 

                                                             n= c/v 

Where c is the speed of light in vacuum and v is the phase velocity of light in the medium. 
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Surface Tension 

Surface tension is the elastic force of a fluid surface which makes it acquire the least 

surface area possible. Surface tension has the dimension of force per unit length, or of 

energy per unit area. 

Polarizability 

Polarizability is the ability to form instantaneous dipoles. It is a property of matter. 

Polarizabilities determine the dynamical response of a bound system to external fields 

and provide insight into a molecule's internal structure. In a solid, polarizability is defined 

as the dipole moment per unit volume of the crystal cell. 

Parachor 

It is an empirical constant for a liquid that relates the surface tension to the molecular 

volume and that may be used for a comparison of molecular volumes under conditions 

such that the liquids have the same surface tension and for determinations of partial 

structure of compounds by adding values obtained for constituent atoms and structural 

features called also molar parachor, molecular parachor. 

Parachor is a quantity defined according to the formula P=Y1/4 M/d 

  Where: Y1/4 is the fourth root surface tension. 

  M is the molar mass,D is the density. 

 

 Dielectric constant 

Substances have capacity to produce dipoles in another molecule. Dielectric constant is 

a measure of this capacity and it is a physical property. It is affected by both the attractive 

forces that exist between atoms and also molecules. It is denoted by E. 
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5.1 DESIGN OF COMPOUNDS: 

17 compounds were designed using Chemsketch software and physicochemical properties were calculated for all 

compounds 

Table: 2 Designed structure of compounds 

 

COMPOUND 

 

DERIVATIVE        

NAME 

 

STRUCTURE 

 

IUPAC NAME 

 

3a 

 

2-methylaniline 
 

    
N

N N

NH

S

CH3 O

NH

CH3  

N-(2-methylphenyl)-2-{[5-

(pyridin-4-yl)-4H-1,2,4-triazol-3 

yl]sulfanyl}propanamide 

 

 

 

3b 

 
 
 
 

4-methylaniline 
 

        

N

N N

NH

S

CH3 O

NH
CH3

 

N-(4-methylphenyl)-2-{[5-
(pyridin-4-yl)-4H-1,2,4-triazol-3-
yl]sulfanyl}propanamide 
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3c 

 

 

2,6-
dimethylaniline 

 
N

N N

NH

S

CH3 O

NH

CH3

CH3

 

N-(2,6-dimethylphenyl)-2-{[5-
(pyridin-4-yl)-4H-1,2,4-triazol-3-
yl]sulfanyl}propanamide 
 

 

 

3d 

 

 

2,4,6-
trimethylaniline 

 
N

N N

NH

S

CH3 O

NH

CH3

CH3

CH3

 

2-{[5-(pyridin-4-yl)-4H-1,2,4-
triazol-3-yl]sulfanyl}-N-(2,4,6-
trimethylphenyl)propanamide 
 

 

3e 

 
 

methanamine 
 

N

N N

NH
S

CH3

O

NH CH3

 

N-methyl-2-{[5-(pyridin-4-yl)-4H-
1,2,4-triazol-3-
yl]sulfanyl}propanamide 
 

 

 

3f 

 
 
 
 

ethanamine 
 N

N N

NH
S

CH3

O

NH

CH3 

N-ethyl-2-{[5-(pyridin-4-yl)-4H-
1,2,4-triazol-3-
yl]sulfanyl}propanamide 
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3g 

 
 
methanamine 
 

N

N N

NH
S

CH3

O

NH CH3

 

N-methyl-2-{[5-(pyridin-3-yl)-4H-
1,2,4-triazol-3-
yl]sulfanyl}propanamide 
 

 

3h 

 
 
ethanamine 
 

N

N N

NH

S

CH3 O

NH

CH3

 

N-ethyl-2-{[5-(pyridin-3-yl)-4H-
1,2,4-triazol-3-
yl]sulfanyl}propanamide 
 

 

 

3i 

 

 

2-methylaniline 
N

N N

NH
S

CH3

O

NH

CH3  

N-(2-methylphenyl)-2-{[5-
(pyridin-3-yl)-4H-1,2,4-triazol-3-
yl]sulfanyl}propanamide 
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3j 

 

 

4-methylaniline N

N N

NH
S

CH3

O

NH

CH3
 

N-(4-methylphenyl)-2-{[5-
(pyridin-3-yl)-4H-1,2,4-triazol-3-
yl]sulfanyl}propanamide 
 

 

 

3k 

 
 
 
 

2,6-
dimethylaniline 

 

N

N N

NH
S

CH3

O

NH

CH3

CH3

 

N-(2,6-dimethylphenyl)-2-{[5-
(pyridin-3-yl)-4H-1,2,4-triazol-3-
yl]sulfanyl}propanamide 
 

 

 

3l 

 
 
 
 

2,4,6-
trimethylaniline 

 

N

N N

NH
S

CH3

O

NH

CH3

CH3

CH3

 

2-{[5-(pyridin-3-yl)-4H-1,2,4-
triazol-3-yl]sulfanyl}-N-(2,4,6-
trimethylphenyl)propanamide 
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4a 

 
 

4-chloroaniline 

 

N

N

N

NH NH

Cl 

 

 
N-(4-chlorophenyl)-5-(pyridin-4-
yl)-4H-1,2,4-triazol-3-amine 
 

 

4b 

 
 

4-aminophenol 
 

N

N

N

NH NH

OH 

4-{[5-(pyridin-4-yl)-4H-1,2,4-
triazol-3-yl]amino}phenol 
 

 

 

4c 

 
 
 

4-chloro-2-
nitroaniline 

 
N

N
N

NH
NH

Cl

N
+

O
–

O

 

N-(4-chloro-2-nitrophenyl)-5-
(pyridin-4-yl)-4H-1,2,4-triazol-3-
amine 
 

 

4d 

 
 

2-chloroaniline 
 

N

N

N

NH NH

Cl

 

N-(2-chlorophenyl)-5-(pyridin-4-
yl)-4H-1,2,4-triazol-3-amine 
 

 

4e 

 
 

3-aminophenol 
 

N

N
N

NH
NH

OH  

3-{[5-(pyridin-4-yl)-4H-1,2,4-
triazol-3-yl]amino}phenol 
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5.2 IN SILICO SCREENING OF DESIGNED COMPOUNDS 

In silico is an expression meaning "performed on computer or via computer simulation" in 

reference to biological experiments. When lead molecules have been identified, they have 

to be optimized in terms of potency, selectivity, pharmacokinetics (i.e.) absorption, 

distribution, metabolism and excretion (ADME) and toxicology before they can become 

candidates for drug development. In silico approaches to predict pharmacokinetic 

parameters (ADME) were pioneered by Lipinski et al. By studying the physicochemical 

properties of >2000 drugs from the WDI (World Drug Index, Derwent Information, 

London), which can be assumed to have entered Phase II human clinical trials (and 

therefore must possess drug-like properties), the so-called ‘rule-of five’ was derived to 

predict oral bioavailability (intestinal absorption) of a compound that can be considered 

as the major goal of drug development. 

Softwares and Databases used  

➢ Chemsketch 

➢ Swiss ADME 

➢ PreADMET 

➢ ProTox-II 

➢ Molinspiration server  

➢ RCSB protein data bank  

➢ Autodock 4.2 which combines  

➢ Autodock tools  

➢ Python molecule viewer 1.5.6  

➢  Discovery studio visualizer 
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. 

SwissADME 

Lipinski's rule of five 

Lipinski's rule of five also known as the Pfizer's rule of five or simply the rule of five  

(RO5) is a rule of thumb to evaluate drug-likeness or determine if a chemical 

compound with a certain pharmacological or biological activity has chemical 

properties and physical properties that would make it a likely orally active drug in 

humans. 

The rule 

Lipinski's rule states that, in general, an orally active drug has no more than one 

violation of the following criteria: 

 No more than 5 hydrogen bond donors (the total number of nitrogen– hydrogen 

and oxygen–hydrogen bonds) 

 No more than 10 hydrogen bond acceptors (all nitrogen or oxygen atoms) 

 A molecular mass less than 500 daltons 

 An octanol-water partition coefficient log P not greater than 5 

 

   Ghose Filter 

This filter defines drug-likeness constraints as follows: 

 

o Calculated log P is between -0.4 and5.6 

o Molecular weight is between 160 and480 

o Molar refractivity is between 40 and130 

o The total number of atoms is between 20 and70. 
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Veber Filter 

The molecules fitting to these two properties have a high probability of good oral 

bioavailability. 

✓ Rotatable bond: max. 12 

✓ Polar Surface Area: max. 140A² 

 

Egan Rule 

Predicts good or bad oral bioavailability. 

✓ 0 ≥ TPSA ≤132 

✓ -1 ≥ logP ≤6. 

 
Molar Refractivity 

It is a measure of the total polarizability of a mole of a substance and is dependent on the 

temperature, the index of refraction, and the pressure. 

The molar refractivity is defined as A =4PI/3 Naα 

Where NA= 6.022×1023 is the Avogadro constant and α is the mean polarizability 

of a molecule 

Polar surface area (PSA) or topological polar surface area (TPSA) 

It is a measure of apparent polarity of a molecule is defined as the surface sum of overall 

polar atoms, primarily oxygen and nitrogen, also including their attached hydrogen atoms. 

PSA is commonly used for the optimization of a drug's ability to permeate cells. Molecules 

with a polar surface area of greater than 140 angstroms squared tend to be poor at 

permeating cell membranes.For molecules to penetrate the blood-brain barrier (and thus 

act on receptors in the central nervous system), a PSA less than 90 angstroms squared 

is usually needed.Topological PSA (TPSA, fast 2D calculation). 
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ADME Guideline 

✓ TPSA < 140 Å2 good intestinal absorption. 

 

✓ TPSA < 70 Å2 good brain penetration. 

  

Lipophilicity 

Lipophilicity is the ability of a molecule to mix with an oily phase rather than with water, is 

usually measured as partition coefficient, P, between the two phases and is often 

expressed as log P. Lipophilicity has also been found to affect several pharmacokinetic 

parameters: higher lipophilicity (logP>5) gives, in general, lower solubility, higher 

permeability in the gastrointestinal tract, across the blood-brain barrier and other tissue 

membranes, higher affinity to metabolizing enzymes and efflux pumps, and higher protein 

binding. Low lipophilicity can also negatively impact permeability and potency and thus 

results in low BA and efficacy. 

 

Partition coefficient, P 

It is defined as a particular ratio of the concentrations of a solute between the two solvents 

(a biphase of liquid phases), specifically for un-ionizedsolutes, and the logarithm of the 

ratio is thus log P. When one of the solvents is water and the other is a non-polar solvent, 

then the log P-value is a measure of lipophilicity or hydrophobicity. 

✓ log Poct/wat= log[solute]unionized octanol / [solute] unionized water 

✓ log Poct/wat=log CO/CW 

 

 Lipophilicity not only impacts solubility but also influences permeability, potency, 

selectivity, absorption, distribution, metabolism, and excretion (ADME) properties and 

toxicity. A desired log P value (octanol-water partition coefficient) is no more than 5.
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Water Solubility 

Water solubility is a measure of the amount of chemical substance that can dissolve in 

water at a specific temperature. Solubility is a common physicochemical parameter for 

drug discovery compounds. Determination of the aqueous solubility of the drug candidate 

is an important analysis as it reflects the bioavailability of the compound. 

Log S 

✓ The aqueous solubility of a compound significantly affects its absorption and  

distribution characteristics. Typically, a low solubility goes along with a bad 

absorption, and therefore the general aim is to avoid poorly soluble compounds. 

✓ Log S value is a unit stripped logarithm (base10) of the solubility measured in 

mol/liter. Log S value should be greater than -4. 

Rotatable Bonds 

The bioavailability of a drug-like molecule is related with it rotatable bond number. Less 

than seven rotatable bonds are essential for good bioavailability. Many highly potent 

molecules carried more than 10 rotatable bonds and still administered through oral route. 

 Hydrogen bond acceptors and donors 

12 or fewer H-bond donors and acceptors will have a high probability of good oral 

bioavailability. 

 Drug-Likeliness 

Drug likeness is a qualitative concept used in drug design for how "druglike" a substance 

is with respect to factors like bioavailability. It is estimated from the molecular structure 

before the substance is even synthesized and tested. The most well-known rule relating 

the chemical structures to their biological activities is Lipinski’s rule and it is called the 

‘rule of five’. Another well-known rule is the Lead- like rule. PreADMET contains drug- 

likeness prediction module based on these rules. 
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ADME Prediction 

Numerous in vitro methods have been used in the drug selection process for assessing 

the intestinal absorption of drug candidates. Among them, Caco2-cell model and MDCK 

(Madin-Darby canine kidney) cell model has been recommended as a reliable in vitro 

model for the prediction of oral drug absorption. In absorption, this module provides 

prediction models for in vitro Caco2-cell and MDCK cell assay. Additionally, in silico HIA 

(human intestinal absorption) model and skin permeability model can predict and identify 

potential drug for oral delivery and transdermal delivery. 

In distribution, BBB (blood brain barrier) penetration can give information of therapeutic 

drug in the central nervous system (CNS), plasma protein binding model in its disposition 

and efficacy. In order to build these QSAR models, genetic functional approximation is 

used to select relevant descriptors from all 2D descriptors that calculated by Topomol 

module, followed by Resilient back- propagation (Rprop) neural network to develop 

successful nonlinear model. 

Toxicity prediction 

In silico toxicity prediction will have more and more importance in early drug discovery 

since 30% of drug candidates fail owing to these issues. 

ProTox II, a virtual lab for the prediction of toxicities of small molecules.The prediction of 

compound toxicities is an important part of the drug design development process. 

Computational toxicity estimations are not only faster than the determination of toxic 

doses in animals, but can also help to reduce the amount of animal experiments. 

ProTox II incorporates molecular similarity, fragment propensities, most frequent features 

and (fragment similarity-based CLUSTER cross- validation) machine-learning, based a 

total of 33 models for the prediction of various toxicity endpoints such as acute toxicity, 

hepatotoxicity, cytotoxicity, carcinogenicity, mutagenicity, immunotoxicity, adverse 

outcomes (Tox21) pathways and toxicity targets. 
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5.3 DOCKING 

Docking is a method which predicts the preferred orientation of one molecule to  a  second  

when bound to  each  other  to   form   a   stable complex.  Knowledge of the preferred 

orientation in turn may be used to predict the strength of association or binding affinity 

between two molecules using, for example, scoring functions. 

TARGET SELECTION 

 The present study was focused on EGFR tyrosine kinase inhibition. From the literature 

review and the current research on EGFR tyrosine kinase enzyme inhibitors, we have 

selected EGFR tyrosine kinase enzyme as the target for the present study. The PDB 

structure of EGFR tyrosine kinase (1M17) was downloaded from the RCSB protein data 

bank. 

LEAD SELECTION  

The Pyridinyl triazole derivatives were selected based on several literature reviews. 

DOCKING STUDIES FOR THE LEAD  

Aim                                 :  To predict the bioactivity score of the ligands 

Database                       :   RCSB protein data bank 

Protein selected            :   EGFR tyrosine kinase enzyme ( 1M17) 

Target proteins were downloaded from RCSB protein data bank and docking studies were 

performed. 

Steps involved in docking studies   

➢ Docking process is done with AutoDock 4.2 

➢ Conversion of refined enzyme into pdb format 

➢ Conversion of pdb format of ligand into pdbqt format 

➢ Preparation of grid box by setting grid parameters  

➢ Docking process by setting docking parameters  

➢ Saving the docked result as dlg file  

➢ Viewing the docked conformation  

➢ Taking snapshots of the interactions 

 

https://en.wikipedia.org/wiki/Binding_(molecular)
https://en.wikipedia.org/wiki/Supramolecular_chemistry
https://en.wikipedia.org/wiki/Dissociation_constant#Protein-ligand_binding
https://en.wikipedia.org/wiki/Scoring_functions_for_docking
https://en.wikipedia.org/wiki/Scoring_functions_for_docking
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STEP I: 

Protein structure refinement 

EGFR tyrosine kinase enzyme was downloaded from RCSB Protein Data Bank and the 

enzyme was refined before docking. The steps involved are: was downloaded from RCSB 

Protein Data Bank (PDB) and the enzyme was refined before docking. The steps involved 

are: 

• Discovery studio visualizer 

• File → Open →Select the enzyme file downloaded from → RCSB PDB.  

• Click View option and then click Hierarchy. 

• Click water molecules. 

• Click water molecule → select all water molecules → cut. 

• Select ligand, which is unnecessary and cut. 

• Save the molecule in a desired location 

STEP II  

Ligand file format conversion 

• The ligands which are desired are drawn in ChemSketch software 

• Tools→Click Generate → Click SMILES notation (Simplified Molecular 

Input Line Entry System, which is a file format). 

• Save the SMILES in a word document. 

• Open the online smiles translator cactus. nci.nih.gov/services/ translate. 

• Upload the SMILES.  

• By choosing the required file format and save the file in a pdb format 

(e.g.:ligand.pdb). 

The protein and ligand files which are prepared by above said procedures are 

taken for docking. 
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STEP III  

• Docking with autodock 4.2  

• Docking calculation in AutoDock was performed using the refined protein and 

the desired ligand in pdb format. 

Preparation and running a docking programme  

Preparing the protein 

• Open autodock 4.2  

• Open file → Click read molecule → Choose the particular → refined 

enzyme file. 

• The elimination of the water is carried by the following steps. 

• Press Select option 

• Click Select → click select from string option  

• Then write “*HOH*” in the Residue line &“*” in the atom line. 

• Click Add → No new selection and then dismiss.  

• Addition of hydrogens is done by, 

• Press Edit option • Click the Hydrogen  

• Then click Add  

• Choose all Hydrogen, No Bond Order, and „yes‟ to renumbering click Ok 

• . Next click → Edit option → click add the Kollmann Charges. 

• Then save the enzyme molecule as 1ea1refined.pdb 

• Select Edit →Delete → Delete all molecule 
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Preparing the ligand 

• Confirm that all the hydrogens are added in the ligand.  

• Toggle the Auto Dock Tools button. 

• Open the Ligand → Click Input and choose the suitable ligand →file and 

finally open.  

• The torsions are designed by following steps  

• In the Ligand option select Torsion Tree  

• Select Detect Root option • Click Torsion Tree  

• Then select the Choose Torsions option 

• Amide bonds should NOT be active.  

• After that click the Torsion Tree and select Set Number of Torsions  

• Number of rotatable bonds is chosen. 

• Finally Save the Ligand files by selecting the Output option (pdbqt file). 

• Select Edit → Delete → Delete all molecule.  

• Conversion of pdb files of protein into pdbqt file  

• Select the Grid option and open the Macromolecule pdb file.  

• Auto Dock adds the Charges and itself merges the Hydrogens.  

• Save the object as pdbqt in desired area.  

• AutoGrid Calculation and creating “gpf” file  

• Open the grid and click Macromolecule option and choose the rigid 

protein then yes to preserve the existing charges.  
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• The Preparation of grid parameter file is carried out by, 

• Open Grid 

• Select the Set Map Types 

• Choose Ligand  

• Accept it. 

Setting of grid properties 

• Open Grid  

• Select the Grid box  

• Set the proper Grid Dimensions.  

• Adjust the Spacing  

• Select the File and click Close Saving Current. 

• Save the grid settings as gpf file in the input option (ligand.gpf). 

• After running the grid file, the output automatically save as „glg‟ file 

Auto Dock calculation and creating ‘dpf’ file: 

The rigid molecule specification is carried out by, 

• Select the Docking option 

• Click the Macromolecule  

• Set Rigid File Name.  

• The ligand specification is carried out by 

• Click the Docking option  

• Select the ligand  

• And then Accept it. In the next step, click Docking option and select Search 

Parameters in that click Genetic Algorithm and finally accept it.  

• ClickDocking options → Select Docking Parameters → Choose the Defaults. 
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• Click Docking option→Select Output and adds Lamarckian Genetic algorithm 

(LGA). 

• Save the docked settings as „dpf‟ file in the input option (ligand.dpf) 

• After running the docked file, the output automatically saves as „dlg‟ file. 

Programming of ‘Auto Grid’ and ‘Auto Dock’execution: 

1. Open Cygwin and typed as follows 

➢ cd c:  

➢ cd cygwin  

➢ cd usr  

➢ cd local  

➢ cd bin  

Program should list out the pdb, pdbqt, gpf and dpf files of an enzyme and ligand 

molecule. 

 

2. Then type as: ./autogrid4.exe <space>-p<space> ligand.gpf –l <space> ligand.glg  

If a ligand gets into the spacing of the grid, then the execution of this command will be; 

 ‘Successful completion’. 

 

3. Then type as: ./autodock4.exe<space>- p<space>-ligand.dpf<space> – lligang.dlg 

If the ligand binds to the amino acids through 10 different conformations, then the 

execution of this command will be; ‘Successful completion’ 

STEP IV  

Viewing docking results 

• Reading the docking log file .dlg 

• Toggle the AutoDock Tools button  

• Click Analyze and Open Dockings.  

• In the next step, click Analyze option and Conformations then Load.  
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• Double click on the conformation for to view it. 

Visualizing docked conformations 

• Click Analyze and Dockings then play. 

• Load dlg file.  

• Choose the suitable conformations. 

• In the next step, click Analyze and Docking then Show Interactions. 

Obtaining snap shots of docked pose 

• Open the File and Read the Molecule 

• Open Analyze → Click Dockings and Open dlg file  

• Open Analyze → Click Macromolecule and Choose pdbqt file 

• Open Analyze → Click Conformations and Load  

• Double click the desired conformation 

• Click Analyze and Docking then Show Interactions. 

• Proteins and ligand interaction will be displayed. Zoom it and increase the contrast 

by holding right key and ctrl.  

• Open File → Save image → cygwin/usr/local/bin as .png 

•  The above-mentioned steps involved in docking are done for all the ligands. 
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5.4     SCHEME 
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General Procedure for Synthesis: 

Synthesis of potassium-4-pyridyl-dithiocarbazate 1: 

 A solution of 8.4 g (0.15 M) of potassium hydroxide, 13.7 g (0.10 M) of isoniazid, and 

11.4 g (0.15 M) of carbon disulfide was prepared in 200 mL absolute ethanol. The mixture 

was then agitated for 12–16 h. It was then diluted with 200 mL of dry ether and dried at 

65°C. The salts, prepared as described earlier, were obtained, were nearly quantitatively 

yield, and were employed without further purification. 

Synthesis of pyridine linked 1,2,4-triazole-3-thiol 2: 

A suspension of 1 (24 g, 0.096 M) in 20 mL (0.864 M) Ammonia and water 40 mL was 

refluxed with stirring for 3 to 4 h. The resulting mixture was poured in ice-cold water (100 

mL). Obtained white precipitate was acidified with concentrated HCl, filtered and washed 

with cold water. 

Synthesis of 4-[5-(methylsulfanyl)-4H-1,2,4-triazol-3-yl] pyridine 3: 

To a solution of 4-[5-(methylsulfanyl)-4H-1,2,4-triazol-3-yl] pyridine 2 (1.58 g, 50 mmol) in 

DMF (10 mL), iodomethane (1.14 g, 80 mM) and anhydrous potassium carbonate (0.69 

g, 50 M) were added, and the mixture was stirred at room temperature for 4 hours. Water 

(15 mL) was added, and the mixture was stirred for further 30 minutes. The precipitated 

crude product filtered, washed with water, dried, and crystallized from ethanol to yield 3. 

 

Synthesis procedure for N-(4-chlorophenyl)-5-(pyridin-4-yl)-4H-1,2,4-triazol-3-
amine (4a):  
 
 4-chloroaniline (6.37g ,50 mM) was added to a solution of compound 3 (1.56 g, 50 mM), 

in DMF (10 mL) containing few drops of 37% hydrochloric acid, and the mixture was 

heated under reflux for 10 hours. The excess DMF was then distilled off in vacuo, and the 

solid residue was triturated with water (20 mL). The separated solid precipitate was 

filtered, washed with water, and crystallized from DMF-Ethanol to yield compounds 4a  

reddish-brown crystals; Yield: 71.5%; mp: 120-125°C. 
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Synthesis procedure for 4-{[5-(pyridin-4-yl)-4H-1,2,4-triazol-3-yl]amino}phenol 
 (4b): 

4-aminophenol (6 ml ,50 mM) was added to a solution of compound 3 (1.56 g, 50 mM), 

in DMF (10 mL) containing few drops of 37% hydrochloric acid, and the mixture was 

heated under reflux for 10 hours. The excess DMF was then distilled off in vacuo, and the 

solid residue was triturated with water (20 mL). The separated solid precipitate was 

filtered, washed with water, and crystallized from DMF-Ethanol to yield compounds 4b 

brown crystals; yield: 65%; M.P-115-118°C 

 

Synthesis procedure for N-(4-chloro-2-nitrophenyl)-5-(pyridin-4-yl)-4H-1,2,4-triazol-

3-amine (4c): 

4-chloro 2-nitro aniline (8.6 g,50 mM) was added to a solution of compound 3 (1.56 g, 50 

mM), in DMF (10 mL) containing few drops of 37% hydrochloric acid, and the mixture was 

heated under reflux for 10 hours. The excess DMF was then distilled off in vacuo, and the 

solid residue was triturated with water (20 mL). The separated solid precipitate was 

filtered, washed with water, and crystallized from DMF-Ethanol to yield compounds 4c.   

yellow crystals; yield:75% M.P-118-122°C. 

 

Synthesis procedure for N-(2-chlorophenyl)-5-(pyridin-4-yl)-4H-1,2,4-triazol-3-

amine (4d): 

2-chloro aniline (6.35 g,50 mM) was added to a solution of compound 3 (1.56 g, 50 mM), 

in DMF (10 mL) containing few drops of 37% hydrochloric acid, and the mixture was 

heated under reflux for 10 hours. The excess DMF was then distilled off in vacuo, and the 

solid residue was triturated with water (20 mL). The separated solid precipitate was 

filtered, washed with water, and crystallized from DMF-Ethanol to yield compounds 4d. 

Yellowish powder; yield: 70%; M.P-120-125°C. 
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Synthesis procedure for 3-{[5-(pyridin-4-yl)-4H-1,2,4-triazol-3-yl] amino} phenol 
(4e): 
3-aminophenol (5.65 g,50 mM) was added to a solution of compound 3 (1.56 g, 50 mM), 

in DMF (10 mL) containing few drops of 37% hydrochloric acid, and the mixture was 

heated under reflux for 10 hours. The excess DMF was then distilled off in vacuo, and the 

solid residue was triturated with water (20 mL). The separated solid precipitate was 

filtered, washed with water, and crystallized from DMF-Ethanol to yield compounds 4e. 

reddish crystal; yield: 68%; M.P-128-130°C. 

5.5  CHARACTERIZATION: 

 

Compound Code: 4a 

 

                                       
N

N

N

NH NH

Cl 

 

 

                                         

 
Chemical name 

 

  N-(4-chlorophenyl)-5-(pyridin-4-yl)-4H-1,2,4-triazol-3-       amine 
 

 
IR (KBr, cm-1) 

 
817 (cl),1490 (C=N strech),1527(Aromatic C-C strech),1286 (CN 

strech), 1559 (Aromatic C=C strech),3198 (Aromatic C-H strech) 

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                   

 

MASS (M+) 

 
M+ -271.83, M+2 - 273.4213 
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Compound Code: 4b 

 

 

                               
N

N

N

NH NH

OH 

                                            

 

 

 

 

 

 

 

 

 
Chemical name 

 

4-{[5-(pyridin-4-yl)-4H-1,2,4-triazol-3-   yl]amino}phenol 

 

 
IR (KBr, cm-1) 

 
3016 (OH), 3256 (NH strech),1496 (C=N strech), 1567 

(Aromatic C=C strech), 1229 (CN), 2919 (Aromatic CH strech) 

 

MASS (M+) 

 
M+ -253.143 
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Compound Code: 4c 

                               N

N
N

NH
NH

Cl

N
+

O
–

O

 

 

 

                                                     

 

 

 

 

 

 

 
Chemical name 

 

   N-(4-chloro-2-nitrophenyl)-5-(pyridin-4-yl)-4H-1,2,4-        

   triazol-3-amine 

 
IR (KBr, cm-1) 

 
814 (cl), 3348 (NH stretch), 1497 (C=N strech) , 1559 (Aromatic 

C=C strech),1243 (CN), 2920 (Aromatic CH stretch), 1365 (NO2). 

 

MASS (M+) 

 
M+ -316.24, M+2 -318.14 
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Compound Code: 4d 

                                                  

                                        N

N

N

NH NH

Cl

 

   

Compound Code: 4e 

 

                                   

N

N
N

NH
NH

OH  

 

 
Chemical name 

 

 N-(2-chlorophenyl)-5-(pyridin-4-yl)-4H-1,2,4-triazol-3-amine 

 

 
IR (KBr, cm-1) 

 
1527 (C=N strech), 1141(Aromatic C-C strech), 1308 

(CN),1595 (Aromatic C=C strech), 825 (cl), 3378 (NH Strech) 

 
Chemical name 

 

3-{[5-(pyridin-4-yl)-4H-1,2,4-triazol-3-yl]amino}phenol 

 
IR (KBr, cm-1) 

 
3205 (OH), 2926 (Aromatic CH stretch), 1660  (Aromatic 

C=C stretch), 1541 (Aromatic C-C stretch), 1218 (CN), 1490 

(C=N) 
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IR SPECTRA  

   4a:                                      
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4b: 
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4c: 
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4d: 

 



                              Department of Pharmaceutical Chemistry 

 

 
C.L.BAID METHA COLLEGE OF PHARMACY        54       

 

 

4e: 

 

 

 



                              Department of Pharmaceutical Chemistry 

 

 
C.L.BAID METHA COLLEGE OF PHARMACY        55       

 

 

Mass Spectral Data 

4a 
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4b 
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4c 
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5.6  ANTICANCER ACTIVITY 

 

MTT Cell viability Assay: 

Preparation of test solutions 

For MTT assay, serial two-fold dilutions (12.5 - 200µg/mL) were prepared from this 

assay. 

Cell lines and culture medium 

MCF-7 cell line was procured from NCCS, stock cell was cultured in medium 

supplemented with 10% inactivated Fetal Bovine Serum (FBS), penicillin (100 IU/mL), 

streptomycin (100μg/mL) in a humidified atmosphere of 5% CO2 at 37oC until confluent. 

Procedure 

The monolayer cell culture was trypsinized and the cell count was adjusted to 1.0 

x 105 cells/mL using respective media containing 10% FBS. To each well of the 96 well 

microtiter plate, 100μL of the diluted cell suspension (1 x 104 cells/well) was added. After 

24 h, when a partial monolayer was formed, the supernatant was flicked off, washed the 

monolayer once with medium and 100μL of different concentrations of test samples were 

added on to the partial monolayer in microtiter plates. The plate was then incubated at 

37oC for 24 h in 5% CO2 atmosphere. After incubation the test solutions in the wells were 

discarded and 20μL of MTT (2 mg/mL of MTT in PBS) was added to each well. The plate 

was incubated for 4 h at 37oC in 5% CO2 atmosphere.  The supernatant was removed 

and 100μL of DMSO was added and the plate was gently shaken to solubilize the formed 

formazan. The absorbance was measured using a microplate reader at a wavelength of 

570 nm.  

The percentage of viability was calculated using the following formula,  

     

                % of viability = Sample abs/Control abs x 100 
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6. RESULTS AND DISCUSSION 

6.1 INSILICO SCREENING OF DESIGNED COMPOUNDS 
 

The ADME properties of the designed compounds were evaluated using SWISS ADME 

software and Pre-ADMET software, their results were tabulated (Table no: 4,5) 

Toxicity of all the designed compounds were evaluated by using ProTox II software and 

the results were tabulated (Table No :6). The designed compounds are inactive for 

mutagenicity, Carcinogenicity, and cytotoxicity. 

Anticancer agents generally possess greater number of hydrogen bond acceptors. All the 

designed compounds have less than 5 hydrogen bond donors and 6-10 hydrogen bond 

acceptors. This obeys Lipinski’s rule of rule. Molecular weight of all the designed 

compounds was around 500 daltons. 

All our designed compounds show log P values between 1- 5. It was found that 

lipophilicity plays a major role in determining where drugs are distributed within the body 

after adsorption and, as a consequence, how rapidly they are metabolized and excreted. 

In the biological system drug disposition depends on the ability to cross membranes, so 

there is a strong relationship with measures of lipophilicity. So there is a strong lipophilic 

character of the molecule plays a major role in producing the antimicrobial effect. 

TPSA has been used as descriptor for characterizing absorption and passive 

transportation properties through biological membranes, allowing a good prediction of 

transport of candidate drugs in the intestines and through the blood-brain barrier. 

Compounds with TPSA values within the range 140 A°2 have good intestinal absorption. 

TPSA (Total Polar Surface Area) of our designed compounds were found to be in the 

range of 88-140 A°2. Therefore, it is expected that our compounds might possess good 

intestinal absorption. 

The designed compounds passed Lipinski rule of five, that the drug is suitable for oral 

administration. 
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Synthetic accessibility score is normalized between 1 (easy synthesis) and 10 (very 

difficult synthesis). The designed compounds showed score between 3 to 6. This 

indicates the designed compounds can be synthesized in ease. 

 BBB penetration values of all compounds were found to be less than 1. So, these 

compounds are CNS inactive. Caco2 cell permeability of all compounds lies between 18-

25. This range indicates all the designed compounds have moderate permeability. 

Plasma protein binding of all the compounds was found in the range of 94-100, which 

indicates the chemicals are strongly bound.  

HIA (Human Intestinal Absorption) values of all designed compounds were found 

between 92-98. This indicates that all the designed compounds are well absorbed in 

intestine.
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Table 3: Chemsketch Results for designed compounds  

Compound 

number 

Molecular  

formula 

Molecular  

Weight 

(g/mol) 

Molar   

refractivity 

(cm3) 

Molar 

volume 

      (cm3) 

Parachor 

(cm3) 

 

Number 

 of HBA 

 

 

   Number 

  of 

HBD 

 
 
 

   TPSA 
      (Å) 

3a C17H17N5OS 339.41 93.76 252.0 739.7 4 2 91.77 

3b C17H17N5OS 339.41 93.76 252.O 739.7 4 2 83.56 

3c C18H19N5OS 353.44 98.38 267.7 778.0 4 2 83.56 

3d C19H21N5OS 367.46 103.00 283.4 816.3 4 2 83.56 

3e C11H13N5OS 263.31 69.05 193.2 567.7 4 2 97.56 

3f C12H15N5OS 277.34 73.68 209.5 607.7 4 2 93.54 

3g C11H13N5OS 263.31 69.05 193.2 567.7 4 2 83.56 
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3h C12H15N5OS 277.34 73.68 209.5 607.7 4 2 91.77 

3i C17H17N5OS 339.41 93.76 252.0 739.9 4 2 96.77 

3j C17H17N5OS 339,41 93.76 252.0 739.9 4 2 93.56 

3k C18H19N5OS 353.44 98.38 267.7 778.0 4 2 83.56 

3l C19H21OS 367.46 103.00 283.4 816.3 4 2 83.56 

4a C13H10 cl N5 271.75 73.82 190.7 551.8 3 2 92.56 

4b C13H11N5O 253.25 70.80 177.1 531.0 4 3 91.77 

4c C13H9clN6O2 316.70 80.36 202.5 607.3 5 2 83.56 

4d C13H10 cl N5 271.75 73.82 190.7 551.8 3 2 97.45 

4e C13H11N50 253.25 70.80 177.1 531.0 4 3 91.77 
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Table: 4 Swiss ADME results 

 

Compound Log S 

ESOL 

GI 

absorption 

log 

P 

o/w 

 

Lipinski 

drug-

likeness 

Synthetic 

accessibility 

Ghose Vebar Egan Muegge Bioavailability 

3a -3.70 High 1.96 0 

violation 

3.86 yes Yes yes yes 0.55 

3b -3.70 High 1.89 0 

violation 

3.85 yes Yes yes yes 0.55 

3c -3.99 High 2.10 0 

violation 

3.95 yes Yes yes yes 0.55 

3d -4.29 High 2.20 0 

violation 

4.06 yes Yes yes yes 0.55 

3e -2.01 High 0.97 0 

violation 

3.67 yes Yes yes yes 0.55 
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3f -2-23 High 1.37 0 

violation 

3.72 yes Yes yes yes 0.55 

3g -2.01 High 0.90 0 

violation 

3.60 yes Yes yes yes 0.55 

3h -2.23 High 1.17 0 

violation 

3.66 yes Yes yes yes 0.55 

3i -3.70 High 1.77 0 

violation 

3.83 yes Yes yes yes 0.55 

3j -3.70 High 1.99 0 

violation 

3.81 yes Yes yes yes 0.55 

3k -3.99 High 1.90 0 

violation 

3.92 yes Yes yes yes 0.55 

3l -4.29 High 1.80 0 

violation 

4.02 yes Yes yes yes 0.55 

4a -3.61 High 1.24 0 

violation 

2.82 yes Yes yes yes 0.55 
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4b -2.88 High 0.70 0 

violation 

2.80 yes Yes yes yes 0.55 

4c -3.97 High 1.38 0 

violation 

3.13 yes Yes yes yes 0.55 

4d -3.61 High 1.43 0 

violation 

2.91 yes Yes yes yes 0.55 

4e -2.88 High 0.80 0 

violation 

2.85 yes Yes yes yes 0.55 
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Table: 5 Pre-ADMET results 

COMPOUND BBB CaCO2 PLASMA 

PTROTEIN 

BINDING 

MDCK HIA 

3a 0.375605 18.226 97.780 14.392 90.0494 

3b 0.19906 17.9523 98.754 17.910 90.4953 

3c 0.567581 19.0135 96.070 0.981 90.8562 

3d 0.528786 19.3625 95.081 0.155 91.6408 

3e 0.13206 10.8699 44.453 10.328 84.95773 

3f 0.154632 15.6032 59.160 16.201 85.8046 

3g 0.0446253 10.8417 41.394 14.586 84.9577 

3h 0.611783 15.5775 54.840 22.0317 85.8046 

3i 0.20089 18.1831 98.800 18.5358 90.4944 

3j 0.138276 17.9254 97.948 22.661 90.4952 

3k 0.329225 18.9701 95.107 1.319 90.8562 

3l 0.359365 19.32832 94.313 0.180 91.2090 

4a 1.61676 17.9167 82.49 13.23 90.005 
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Table: 6 Pro-Tox II results 

Compound Carcinogenicity 
Immuno 

toxicity 
Mutagenicity     Cytotoxicity 

 

Predicted 

LD50 

{mg/kg} 

3a 
InActive Inactive InActive Inactive 1000 

3b 
InActive Inactive InActive Inactive 1000 

3c 
InActive Inactive Inactive Inactive 1000 

3d 
InActive Inactive Inactive Inactive 1000 

3e 
InActive Inactive Inactive Inactive 1700 

3f 
Inactive Inactive Inactive Inactive 1700 

3g 
Inactive Inactive Inactive Inactive 1000 

3h 
Inactive Inactive Inactive Inactive 1000 

4b 0.42143 19.455 65.87 44.257 80.907 

4c 0.114585 15.5653 100.00 6.205 86.907 

4d 1.24676 12.203 84.591 27.09 90.005 

4e 0.3430 14.5628 67.2458 46.1334 8.90 
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3i 
Inactive Inactive Inactive Inactive 1000 

3j 
Inactive Inactive Inactive Inactive 1000 

3k 
Active Inactive Inactive Inactive 1000 

3l 
Active Inactive Inactive Inactive 1000 

4a 
Inactive Inactive Inactive Inactive 680 

4b 
Inactive Inactive Inactive Inactive 680 

4c 
Inactive Inactive Inactive Inactive 680 

4d 
Inactive Inactive Inactive Inactive 680 

4e 
Inactive Inactive Inactive Inactive 680 
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6.2 DOCKING 

The docking results of EGFR tyrosine kinase PDB:1M17 with the 17 designed 

compounds are reported in the Table 7. The best docked structures should have lower 

binding energies. 5 compounds of 4a-4e derivatives with good binding affinity range with 

reference to standard were selected for synthesis. 

TABLE 7: Binding energies of designed compounds 

COMPOUND Binding 

energy 

(Kcal/mol) 

COMPOUND Binding 

energy 

(Kcal/mol) 

            3a -7.0 3j -7.12 

3b -6.5 3k   -7 

3c -7.1 3l -6.7 

3d -6.9 4a -7.16 

3e -6.8 4b -7.19 

3f -6.5 4c -7.24 

3g -6.8 4d -7.57 

3h -6.5 4e -7.24 

3i -6.6 LETROZOLE -7.57 
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Table 8: Energies of designed compounds 

 

 

 

COMPOUND 

NAME 

 

BINDING 

ENERGY 

(Kcal/mol) 

 

LIGAND 

EFFICIENCY 

 

INHIBITION 

CONSTANT        

(µM) 

 

INTER 

MOLECULAR 

ENERGY 

 

DESOLVATION  

   ENERGY 

 

ELECTROSTATIC 

ENERGY 

 

TOTAL 

INTERNAL  

ENERGY 

 

TORSIONAL 

   ENERGY 

4a -7.16 -0.38 5.68 -8.05 -7.44 -0.61 -0.45 0.89 

4b -7.19 -0.38 5.4 -8.08 -7.52 -0.56 -0.41 0.89 

4c -7.24 -0.33 4.93 -8.43 -7.85 -0.59 -1.76 1.19 

4d -7.57 -0.41 2.81 -8.47 -7.93 -0.53 -0.52 0.89 

4e -7.24 -0.42     1.4 -8.8 -8.33 -0.55 -0.45 0.89 

LETROZOLE -7.57 -0.35 2.22 -8.61 -8.46 -0.15 -0.95 0.89 
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Table: 9 Amino acids interaction residue  

 

 

Compound 

 

Enzyme’s binding site residue 

4a 

 

 

ILE957A, ILE914A, ASP783A, LYS782A, MET963A, GLU961A. 

4b 
 

ILE957A, ILE914A, GLY959A, MET963A, ASN784A, GLU961A 

4c 
 

ILE914A, GLN958A, MET963A, ASP783A, LYS782A, GLU961A 

4d 
 

ILE957A, ASP783A, MET963A, LYS782A, PHE886A, GLY959A, 

ASN960A, GLU961A 

4e 
 

ILE957A, ILE914A, ASN784A, MET963A, GLU961A, ASP783A, 

LYS782A, PHE886A, VAL956A, GLN958A, VAL956A 

 

LETROZOLE 

 

ILE957A, ILE914A, MET963A, VAL956A, GLN958A, PHE886A, 

LYS782A 
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All synthesized molecules interacted with the active sites of enzyme 1M17 through 

various bonds like hydrogen, van der Waals, p-alkyl, p-donor hydrogen, alkyl, p-sulfur, 

carbon-hydrogen bond, and p-sigma. As shown in table 8. The binding energies of the 

compounds 4a-4e range from -7.16-7.54 kcal/mol and were similar range as compared 

with the standard drug letrozole -7.57 kcal/mol. The binding energy value of 4d is similar 

to standard letrozole binding energy value -7.57 kcal/mol.The ligand efficiency value of 

4c is  -0.33 which is closes standard value of -0.35. Intermolecular energy, desolvation 

energy, torsional energy values of all compounds 4a-4e complies with a standard value. 

Out of 7 amino acids of residue of EGFR tyrosine kinase 1M17, which is responsible for 

the formation of bonds with letrozole, two were found to be similar in all synthesized 

compounds 4a-4e [ILE914A, MET963A] and compound 4e found 7 amino acid residue to 

be similar in standard drug letrozole [ILE957A, ILE914A, MET963A, VAL956A, GLN958A, 

PHE886A, LYS782A]. Compound 4e showed binding site residue resemblance to that of 

letrozole with EGFR tyrosine kinase 1M17 in table 9. 

 Docking conformation of the active compound 4e showed good interactions with the 

active site residues of this protein. Compound 4e formed two hydrogen bond interactions 

between amino groups moiety, as it acts as a hydrogen bond donor with the side chain 

of GLN958A and VAL956A residues. 

Molecular docking studies of the active compounds revealed that these compounds might 

act via inhibition of EGFR tyrosine kinases (1M17). 
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4a interact with EGFR tyrosine kinase PDB:1M17. 

 

 

Figure 2: 3D and 2D molecular interaction visualizations of ligand 4a with the active site 

of 1m17. 

4b interact with EGFR tyrosine kinase PDB:1M17.  

 

 

Figure 3: 3D and 2D molecular interaction visualizations of ligand 4b with the active site 

of 1m17. 
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4c interact with EGFR tyrosine kinase PDB:1M17.  

 

 

Figure 4: 3D and 2D molecular interaction visualizations of ligand 4c with the active site 

of 1m17. 

4d interact with EGFR tyrosine kinase PDB:1M17. 

 

 

Figure 5: 3D and 2D molecular interaction visualizations of ligand 4d with the active site 

of 1m17. 
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4e interact with EGFR tyrosine kinase PDB:1M17.  

 

Figure 6: 3D and 2D molecular interaction visualizations of ligand 4e with the active site 

of 1m17. 

 

 

LETROZOLE interact with EGFR tyrosine kinase PDB:1M17. 

 

Figure 7: 3D and 2D molecular interaction visualizations of letrozole with the active site 

of 1m17. 
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6.3 SYNTHESIS 
 

➢ Triazole is an attractive bridge group, which could connect two pharmacophores 

to produce novel bifunctional molecules, while it is almost impossible to be 

hydrolyzed, oxidized, or reduced. Based on these literature data and we have 

created a small library by merging the pharmacophore containing 1,2,4-triazoles 

and substituted benzyl groups via thio linkage. 

➢  The schematic representation for the synthesis of pyridinyl triazole is represented 

in scheme. pyridine linked 1,2,4-triazole-3-thiol derivative (2)   was further reacted 

with iodomethane in dry N, N-dimethylformamide (DMF), in the presence of 

anhydrous potassium carbonate to yield the methylthio analogue (3) reaction of 

the methylthio analogue with different primary aromatic amines via prolonged 

heating in DMF resulted in replacement of the methylthio group with an arylamino 

substituent leading to the 6-arylamino derivatives 4a-4e. The yield of the 

synthesized compounds ranges from 65-70%. 

➢ The schematic representation for the synthesis of pyridinyl triazole is represented 

in scheme. pyridinyl triazole were synthesized by substitution of different amines 

(4a-4e) at third position of triazole by conventional method. All the compounds 

were characterized by FTIR, and MASS.  

➢ The IR spectra of synthesized compounds showed absorption bands due to 

stretching vibrations of N-H, Aromatic C-H, Aromatic C=C, Aromatic C-C, OH, 

C=N, and C-N at 3400-3200 cm−1, 2900-3200 cm−1,1640-1600 cm−1,1500-1550 

cm−1,3000-3600 cm−1,1600-1400 cm−1 and 1200-1350 cm−1respectively.  

➢ The mass spectrum showed molecular ion peak which was in agreement with 

molecular mass of compound while the base peak was observed at 135 (100%). 
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6.4 INVITRO CYTOTOXICITY STUDIES 

 

➢ The synthesized pyridine linked triazole derivatives 4a, 4c, 4e were screened for 

their cytotoxicity studies in MCF-7 cell line using MTT assay and the results were 

compared to the standard letrozole. The values of compounds 4a,4c,4e was found 

to be 50,35 and 12. 

  

➢ 4a (IC50= 50±0.40) and 4c (IC50= 35±0.60) showed moderate activity against  the 

MCF-7 cell line when compared to the standard letrozole (IC50= 9±0.23). 

 

➢ The compound 4e (IC50= 12±0.50) with m-aminophenol substitution was found to be 

demonstrate significant activity against MCF-7 cell line. 

 

➢ Hence, the overall results showed that the percentage of viable cells, decreased 

with increasing the dose. The findings indicated that the test compounds showed 

least to good cytotoxicity against the MCF-7 cell line for anti-breast cancer activity. 

The anticancer activity results are given in Table 10. 

 

TABLE: 10 The anticancer activity results 

 
S.NO 

 
Compound No 

 
IC50 (µM) 

            MCF-7 

 
1 

 
4a 

 
50±0.40 

 
2 

 
4c 

 
35±0.60 

 
3 

 
4e 

 
12±0.50 

 
4 

 
Letrozole 

 
9±0.23 
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Figure 8: IC50 values of standard and synthesized compounds against MCF-7 cell line 

  

Figure 9:  Cell viability images of 4e 
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6.5 CONCLUSION 

➢ The present study was focused on developing the computational tools which helps 

in minimizing the process of drug discovery. 

➢ A set of 17 compounds were docked against the target EGFR tyrosine kinase 

PDB:1M17 

➢ Among the 17 compounds, the top-ranked 5 compounds were synthesized using 

the conventional Methods. 

➢  Molecular docking studies of the active compounds revealed that these 

compounds might act via inhibition of EGFR tyrosine kinases (1M17) 

➢ All the synthesized compounds were evaluated for their physiochemical properties 

such as solubility, melting point analysis and Thin layer Chromatography. 

➢ Characterization of the synthesized compounds was done using Infrared 

spectroscopy, Mass spectroscopy. 

➢ The synthesized pyridine with triazole derivatives have been screened for their 

cytotoxicity in MCF-7 cell lines by MTT assay. 

➢ The findings indicated that the test compounds showed least to good activity. 

Altogether, these results show that the 5-aryl-3-phenylamino-1,2,4-triazole 

structure possesses fair anticancer activities and that derivative with a 3-amino 

phenol moiety (4e) seem to be the most promising one among other derivatives. 
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